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How to Use This Manual

Be sure to read through this manual when using the EGX-20 for the first time. This manual explains mainly the following 
information.
 Connecting to a computer, installing a blade, mounting an engraving workpiece, and the like
 Installing the driver software on the computer
 The procedure for creating a nameplate using Dr. Engrave (a text-engraving program) 

You can also install and set up the following programs on the included Roland Software Package CD-ROM and use them on 
your computer.
 Virtual MODELA (a program that simulates cutting results obtained with 3D Engrave)
 Dr.Engrave (a text-engraving program)
 3D Engrave (a program for creating reliefs)

Windows driver (a software driver for using the EGX-20 with Windows)
The manuals for these (except for the manual for the driver) are in electronic format. Refer to them for detailed information 
on use.

Manuals in Electronic Format

You can view the manuals in electronic format (PDF files) 
from the setup menu that appears when you insert the 
Roland Software Package CD-ROM in the CD-ROM drive on 
your computer. Load the Roland Software Package CD-ROM 
in the computer’s CD-ROM drive and view the manuals in 
electronic format as required.

To view a description of the program, click the  button. 
To view a manual, click the  button. A PDF manual is 
available for programs listed with a  button.
Acrobat Reader is required to view PDF files. If Acrobat 
Reader is not already installed and set up on your computer, 
then the setup program for Acrobat Reader starts automati-
cally, allowing you to install and set it up.

Help

After you have installed and set up the programs, you can view help for each that contains information similar to the PDF 
files. In Windows, click [Start]. From the menu, point to [Programs], then [Roland 3D Engrave], then select [3D Engrave Help]. 
The help window appears. In the same way, point to [Roland Dr. Engrave] and select [Dr. Engrave Help], or point to [Roland 
Virtual MODELA] and select [Virtual MODELA Help]. Alternatively, start the respective program, then from the [Help] menu, 
select [Contents]. The help window appears.
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 To Ensure Safe Use

Improper handling or operation of this machine may result in injury or damage to property. Points which 
must be observed to prevent such injury or damage are described as follows. 

About  WARNING and  CAUTION Notices

 WARNING Used for instructions intended to alert the user to the risk of death or severe injury 

should the unit be used improperly.

 CAUTION 
Used for instructions intended to alert the user to the risk of injury or material damage 

should the unit be used improperly.

Note: Material damage refers to damage or other adverse effects caused with respect 

to the home and all its furnishings, as well to domestic animals or pets.

About the Symbols

The  symbol alerts the user to important instructions or warnings. The specific meaning of the 

symbol is determined by the design contained within the triangle. The symbol at left means "danger of 

electrocution."

The  symbol alerts the user to items that must never be carried out (are forbidden).  The specific thing 

that must not be done is indicated by the design contained within the circle.  The symbol at left means 

the unit must never be disassembled.

The  symbol alerts the user to things that must be carried out. The specific thing that must be done is 

indicated by the design contained within the circle. The symbol at left means the power-cord plug must 

be unplugged from the outlet.

 WARNING
Never attempt to disassemble, repair, or 
modify the machine.
Doing so may result in fire, electrical shock, 
or injury. Entrust repairs to a trained service 
technician.

Do not use with any electrical power supply 
that does not meet the ratings displayed on 
the AC adapter. 
Use with any other power supply may lead to fire 
or electrocution. 

Do not use while in an abnormal state (i.e., 
emitting smoke, burning odor, unusual 
noise, or the like). 
Doing so may result in fire or electrical shock. 
Immediately unplug the power-cord plug from 
the electrical outlet, and contact your authorized 
Roland DG Corp. dealer or service center. 

 WARNING
Ground the unit with the ground wire.
Failure to do so may result in risk of electrical 
shock in the even of a mechanical problem. 

Do not use with any power supply other 
than the dedicated AC adapter. 
Use with any other power supply may lead to fire 
or electrocution. 

Use only with the power cord included with 
this product. 
Use with other than the included power cord may 
lead to fire or electrocution. 
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 CAUTION
Do not use with a damaged AC adapter, 
power cord, or power-cord plug or with a 
loose electrical outlet. 
Use with any other power supply may lead to 
fire or electrocution. 

When not in use for several hours, unplug 
the power-cord plug from the electrical 
outlet.
Failure to do so may result in danger of shock, 
electrocution, or fire due to deterioration of the 
electrical insulation. 

Do not attempt to unplug the power-cord 
plug with wet hands. 
Doing so may result in electrical shock. 

Install on a stable surface. 
Failure to do so may result in falling of the unit, 
leading to injury. 

Do not inadvertently allow the hands, or 
hair near the rotating parts while in opera-
tion. 
Doing so may result in injury.

When you’re finished, wash your hands to 
rinse away all cuttings.  

 CAUTION
Do not injure or modify the electrical power 
cord, nor subject it to excessive bends, 
twists, pulls, binding, or pinching, nor 
place any object of weight on it. 
Doing so may damage the electrical power 
cord, leading to electrocution or fire. 

When unplugging the electrical power cord 
from the power outlet, grasp the plug, not 
the cord. 
Unplugging by pulling the cord may damage 
it, leading to fire or electrocution. 

Do not allow liquids, metal objects or flam-
mables inside the machine. 
Such materials can cause fire. 

Do not touch the tip of the blade 
Doing so may result in injury.

Wear dust goggles and mask during use. 
Cutting dust may scatter, causing bodily in-
jury. 

 To Ensure Safe Use
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About the Labels Affixed to the AC Adapter and Unit 

These labels are affixed to the body of this product and the AC adapter. The following figure describes the location. 

Rating label 
Do not use with any electrical power 
supply that does not meet the ratings 
displayed on the AC adapter.

Handle tool with care.

Model name

In addition to the  WARNING and  CAUTION symbols, the symbols shown below are also used.

NOTICE Indicates information to prevent machine breakdown or malfunction and ensure 
correct use.

Indicates a handy tip or advice regarding use.

 To Ensure Safe Use
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1  Getting Ready

What You Can Do with the EGX-20

• You can engrave a plate with text or shapes to create a nameplate or the like. 
Using Dr. Engrave, the included 2D engraving program, you can easily engrave anything from simple text to complex 
designs to produce high-quality engraved plates.
 p. 16, "Creating a Nameplate"

• You can cut thick materials up to a depth of 7 mm to create reliefs and other forms. 
Using 3D Engrave, the included 3D engraving program, you can easily produces reliefs and other three-dimensional 
engraved forms. 
 p. 28, "Creating a Relief" 

Check the Included Items

AC adapter: 1 Power cord: 1 Cutter: 1 
(with cutter holder) 

Nose cones 
(large: 1, medium: 1, small: 1)

The medium one is installed on the 
machine.

Adhesive sheet: 1 Test-use plate material: 1

Hexagonal screw driver: 1 Hexagonal wrenches 
(large: 1 and small: 1) 

User's Manual: 1

Roland Software Package
CD-ROM: 1
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Names and Functions

The names of the parts of the EGX-20 are as follows. 

Front

Rear

Switch Panel

Carriage

Depth regulator unit

Table

Z-axis light

Power light

View light

Origin Set light

Movement 
button

Speed 
control

Spindle Speed 
control

Power button

View button

Origin Set 
button

Cover

Spindle motor

Spindle unit

Parallel connector

AC adapter jack
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Setting Up and Connection

Setting

NOTICE
Never install this unit in any of the following situations, as it could result in damage:

• Places where the installation surface is unstable or not level.

• Places with excessive electrical noise.

• Places with excessive humidity or dust.

• The EGX-20 generates heat when used, and should not be installed in an area with poor heat radiation characteristics.

• Places with excessive vibration.

Use within a temperature range of 5 to 40°C (41 to 104°F) and within a humidity range of 35 to 80%.

Securely connect the power cord, computer I/O cable and so on so that they will not be unplugged and cause 
failure during operation.  Doing so may lead to faulty operation or breakdown.

* Do not place any object within the area

10 cm (4 in.)

10 cm (4 in.)

30 cm (12 in.)

30 cm (12 in.)
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Connecting the AC Adapter and Power Cord

Connect in the order of the numbers shown in the figure.

Connecting to the Computer

To connect the machine and the computer, you can use either a parallel cable (IEEE 1284-compliant) . 
The parallel cable is sold separately. Use a cable suited to the configuration of the printer port on your computer. 

NOTICE
Make the cable connections while the computer and the machine are switched off

Computer

Amphenol 36-pin connector

Printer port

AC adapter

Power cord

AC adapter jack
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Attaching the Adhesive Sheet

You use the included adhesive sheet to secure material to engrave to the table on the EGX-20. 

 Press the power button on the EGX-20 
to turn on the power.
The carriage moves to the right edge and 
the table moves to the front, the unit goes 
into View status, and the Power and View 
lights light up. 

 Peel off the protective paper from both 
sides of the adhesive sheet. 

 Place the adhesive sheet on the table as shown in the figure at right, press down on it from 
above, and secure it in place so that it will not peel off. 

NOTICE
Be sure the unit is in View status when attaching the adhesive sheet. 

There are holes at the four corners of the table. 
Align the corner of the adhesive sheet with the lower-left hole. 

Table

Carriage

Adhesive sheet

Table

Adhesive sheet 
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Installing the Cutter Holder

 A cutter holder is attached to the in-
cluded cutter. 
Remove the cutter from the cutter 
holder. 

 Open the cover for the carriage. 

 Orient the cutter holder so that the 
screw is underneath, insert the cut-
ter holder into the spindle unit from 
above, then turn the cutter holder 
counterclockwise by hand to secure 
it in place. 
The spindle unit moves when you do this, so 
insert the included hexagonal screwdriver 
into the hole in the spindle unit as shown in 
the figure to keep it from moving. 

The cutter holder is reverse-threaded. 
Turn it counterclockwise to tighten. 

Cutter Cutter holder

Open the cover 
for the carriage. 
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2  Installing and Setting Up the Software

To use the EGX-20, you need to install the driver on the computer connected to the EGX-20. The EGX-20 also comes with 
a number of programs for creating engraving and cutting data, which you can use to match the target task. To use these 
programs, you need to install and set them up on the computer connected to the EGX-20. 

The Software You Can Install and Set Up

The drivers and programs are contained on the Roland Software Package CD-ROM. Be sure to install the Windows driver. Install 
and set up the other software, the programs, as required. You can use the following drivers and programs with the EGX-20. 

Driver or program Overview

Windows driver This is necessary when sending data from a program running under Windows 
to the EGX-20. Be sure to install it. 

Virtual MODELA

This uses data created with 3D Engrave to perform simulations before cutting 
with the EGX-20. 
You can use it to check the finished shape as well as things like whether the 
cutting depth is suitable and how much time cutting will take. This can reduce 
loss for cutting materials and time.

Dr. Engrave

This is used to design text and shapes to engrave on a plate and to send the 
data to the EGX-20. 
You can use the TrueType fonts registered in Windows as the font style for text. 
You can even make stroke fonts from TrueType fonts.
Because you can the outline of an image and convert it to line segments, it's 
also possible to include logos for companies or organizations in the plates you 
make.

3D Engrave
This adds thickness to a flat (two-dimensional) graphic to create a relief (raised 
engraving).
You can also add thickness to figures and other images. 

System Requirements

The following operating environment is required in order to use the drivers and programs just described. Make sure your 
system configuration meets these requirements. 

Operating system Windows 95/98/Me/NT 4.0/2000/XP

Computer Computer running Windows (Pentium processor or better recommended) 

Drive CD-ROM drive

Monitor Windows-compatible monitor capable of displaying 256 colors or more 

Memory 32 MB or more recommended

Free hard-disk re-
quired for installation 

space

25 MB (combined total for Dr. Engrave, 3D Engrave, and Virtual MODELA) 

Interface Printer port
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Installation and Setup

Follow the steps below to install and set up the driver and programs. 

 Turn on the computer and start Windows. 
If you're running a virus-detection program, then quit the program. Also quit all running programs except 
Windows. In Windows, make sure no program icons appear on the taskbar, then go on to the next step. 

 Insert the included CD-ROM into the CD-ROM drive. 
The setup menu appears automatically. 

 Click the drop-down arrow for [Click 
here], then from the menu that ap-
pears, select [EGX-20]. 
The programs you can install and set up with 
the EGX-20 appear. 

You can view a description for each program 
by clicking the  button next to the corre-
sponding program name. 
Also, to display the Readme file, click the 
[Readme] button. This lets you read the lat-
est information that could not be included 
in the user's manual. Please be sure to read 
it before use. 

NOTICE
If the computer and the EGX-20 are already connected, then switch off the power to the EGX-
20 before you perform installation and setup. 

Installation and set up under Windows 2000/NT 4.0/XP require full access rights for the printer 
settings. Log on to Windows as a member of the "Administrators" or "Power Users" group. For 
more information about groups, refer to the documentation for Windows. 

If the setup menu does not appear automatically even when the included CD-ROM is loaded in the CD-ROM drive, 
then use Windows Explorer to select the CD-ROM drive, then double-click "CDMenu.exe" to run it. 

This document does not contain manuals for the programs, but a manual in PDF format is available for each pro-
gram shown with a  button. Click the button to display the PDF manual. 
Acrobat Reader is required to view PDF files. If Acrobat Reader is not already installed and set up on your computer, 
then the setup program for Acrobat Reader on the included CD-ROM starts automatically, allowing you to install 
and set it up.

If your computer is connected to the Internet, 
the Roland DG Corp. website appears. 
Check this for information about updates to 
the driver and the like. 

132  Installing and Setting Up the Software



 Choose the check boxes which you 
want to install, and then click the [In-
stall] button.
If you do not want to install a particular 
program, than clear the corresponding 
check box. Normally you should select all 
check boxes. 
The setup screen ([Welcome] dialog box) 
appears for the program whose check box 
you selected. 
If you selected the check boxes for all pro-
grams, then the setup screens appear in suc-
cession, starting with Virtual MODELA. 

 Click [Next].
Follow the messages to carry out set-
up and finish setting up the program.

 When installation finishes, a prompt 
dialog box appear. Click [OK]. 
When the installation of one program fin-
ishes, installation of the next one starts. 
In the interval until the next setup starts, a 
dialog box showing the progress of process-
ing is displayed.

 Repeat steps  and  to install and set up each program.

When installation of 3D Engrave finishes

The [EGX-20 Driver Installation] dialog box appears. 
Choose the port for connecting the EGX-20. 
The EGX-20 connects to a printer port. If your computer has a single 
printer port, select [LPT1:]. 
Click [OK]. The EGX-20 driver is installed. 

When installation of the EGX-20 driver finishes

The [Settings: [EGX-20]] dialog box appears. 
Make sure the values are correct, then click [Close]. 
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 When all installation and setup fin-
ishes, a prompt dialog box appears. 
Click [Close]. 

 When the setup menu screen reap-
pears, click the  button. 

 Take the CD-ROM out of the CD-ROM drive. 
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3  Creating a Nameplate (Engraving Mode)

This section describes the basic steps for engraving using the EGX-20, taking the procedure for engraving the plate included 
with the machine as an example. 

Loading Material

 If the EGX-20 is switched off, press 
the power button to turn it on. 
The carriage moves to the right edge and 
the table moves to the front, the unit goes 
into View status, and the Power and View 
lights light up. 
If the EGX-20 is turned on but the View light 
is not illuminated, press the View button. 
The carriage moves to the right edge and 
the table moves to the front, the unit goes 
into View status, and the Power and View 
lights light up. 

 Place the plate on the adhesive sheet, 
then press down on it from above to 
anchor it securely. 
You can place the item anywhere on the 
adhesive sheet. 
However, if the plate is placed at an angle 
with respect to the table, the engraving will 
not be straight. 
Place it so that it is aligned straight with the 
corners and sides of the table. 

NOTICE
Large changes in temperature may alter the cutting depth. Use care when using near an air conditioner or heater. 
In cases like this, reinstall the cutter (thereby realigning it with the reference surface).

Cuttable depth is 0.05 to 1 mm (0.002 to 0.039 in.) in the Engraving mode. Do not attempt cutting that exceeds 
this depth.

In the engraving mode, fill engraving over a broad area (that is, having a width equal to or greater than the diam-
eter of the nose cone) cannot be performed. Such operations are generally classified as "difficult" engraving, but 
they are possible using the 3D cutting 

NOTICE
When you load more than one plate at a time, make sure there are no gaps between them. Plates that are not 
quadrilateral or are of irregular shape may not be suitable for engraving with the EGX-20.

Before you load material, attach the included adhesive sheet. Be sure the unit is in View status when loading 
material. 

Power and View 
lights illuminate.

Place the plate on the adhesive sheet, then press 
down on it from above to anchor it securely. 
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Installing a Cutter

 If the View light on the switch panel 
is lit (showing the machine is in View 
status), press the View button. 
The spindle unit and table move, and the 
spindle unit moves to above the origin point 
on the table. 
When movement ends, the View light goes 
dark.

 Use the movement button on the 
switch panel to move the spindle 
unit.
The movement button is a joystick. 
Pressing the movement button up, down, or 
to the left or right makes the spindle unit and 
table move in the corresponding vertical or 
horizontal direction. 
Move the spindle unit to about the center of 
the plate (material) mounted on the table. 

 Press and hold the center of the 
movement button for short while (0.6 
second or longer). 
The Z-axis light illuminates, indicating that 
it is now possible to move the spindle unit 
up and down. 
 

 Press the lower part of the movement 
button. 
The spindle unit descends while you hold 
down the button. Movement stops auto-
matically when the nose cone contacts the 
plate (material), so release the movement 
button. 

The origin point is a reference point that the EGX-20 uses for starting engraving. When the machine is shipped 
from the factory, the origin point is set at the lower left corner of the table. 
You can also move the spindle unit and the table and set the origin point at a different location. 

 P. 19, "Setting the Origin Point" 

Press up, down, or 
to the left or right. 

Press. 

Origin Point

Nose cone

Press. 
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 Press the Origin Set button on the 
switch panel. 
The spindle unit descends by 0.5 mm and 
the Origin Set light lights up. 
 

 Insert the cutter into the hole in the 
cutter holder, then slowly lower the 
cutter. 
Lower until the cutter touches the plate. 

 Use the included hexagonal screw-
driver to tighten the retaining screw 
for the cutter holder. 
Tighten secure so that the cutter does not 
come loose during engraving. 

 Press the Origin Set button on the 
switch panel. 
The spindle unit rises 0.5 mm and the Origin 
Set light goes dark. 

 

NOTICE
Before you install a cutter, install the cutter 
holder. 

 P. 11, "Installing the Cutter Holder" 

Press. 

Press. 
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Setting the Origin Point

When loading material, be sure to set the origin point. The origin point is the reference point for engraving. You set it indi-
vidually for each piece of material you load. Omitting this operation may result in locations other than the material being 
engraved. 

 Refer to the preceding "Basic Steps 
for Moving the Spindle Unit" and move 
the spindle unit as follows. 

 If the cutter is touching the plate 
(material), move the spindle unit up-
ward to separate it slightly from the 
material. 

 Move the cutter to position it above 
the lower left corner of the plate (ma-
terial). 

 If the Z-axis light is dark, press and hold the Origin Set button for a short while (0.3 second 
or more). 
(Pressing the Origin Set button lights the Origin Set light. Make sure the light is illuminated, then release 
the button. The Origin Set light goes dark.) 
The vertical and horizontal locations of the origin point are set. 
This completes the setting for the origin point. 

 Basic Steps for Moving the Spindle Unit
When you installed the cutter in the spindle unit, you performed operations to move the spindle unit. These steps 
can be summed up as follows. 

 The operation differs according to whether the View light and Z-axis light on the switch 
panel are illuminated or dark. 

 Changing between the lighted View light (indicating View status) and dark View light 
Press the View button on the switch panel. 

 When the View light is illuminated 
You cannot move the spindle unit. 

 When the View light is dark 
You can move the spindle unit using the movement button. 

 Changing between the lighted and dark Z-axis light 
Press and hold the center of the movement button for a short while (0.6 second or more). 

 When the Z-axis light is illuminated 
You can move the spindle unit up and down using the movement button. 

 When the Z-axis light is dark 
You can move the spindle unit vertically or horizontally using the movement button. 

Pressing the Origin Set button while the Z-axis light is lit lowers the spindle unit and puts the machine in the state 
for installing a cutter. 

When you are engraving a nameplate, there is no need to set a height-location origin point. The sensors automati-
cally detect the surface location of the plate (material). 

Plate

Center of the cutter
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Creating Data with Dr. Engrave

This section describes the basic steps for engraving a nameplate using Dr. Engrave. 

Starting Dr. Engrave

In Windows, click the [Start] button. 
At the Start menu, point to [Pro-
grams], then [Roland Dr. Engrave]. 
At the menu that appears, click [Dr. 
Engrave]. 
Dr. Engrave starts. 

Specifying the Size of the Plate to Engrave

Make the size of the engraving area displayed by Dr. Engrave the same as the size of the actual plate to engrave. 
This is analogous to choosing the form size in a word-processing program. 

 In Dr. Engrave, from the [File] menu, select [Print Setup]. 
The [Print Setup] dialog box appears.

 Make sure the printer name is set to 
[Roland EGX-20] (if the printer name 
is not [Roland EGX-20], then click the 
drop-down arrow and select [Roland 
EGX-20]), then click [Properties]. 
The [Roland EGX-20 on LPT1: Properties] 
dialog box appears. 

 Measure the size of the plate to en-
grave with a ruler or the like, type in 
the values in the [Width] and [Length] 
entry boxes, then click [OK]. 

 The [Print Setup] dialog box appears again, then click [OK]. 
The engraving area that Dr. Engrave displays is shown at the size you specified. 

The following explanation is for Windows 95/98/Me. 
For an explanation for Windows NT 4.0/2000/XP, or for a more detailed explanation, see the help for Dr. Engrave 
or refer to the Dr. Engrave User's Manual (PDF) on the Roland Software Package CD-ROM. 

20 3  Creating a Nameplate (Engraving Mode)



Entering Text

Enter the text to engrave on the plate. 

 At the toolbar, click . 

 Click the location in the engraving area where you want to type in text, then enter the text 
using the keyboard. 

Selecting the Font

Specify a font for the text string you entered. 

 At the toolbar, click , then click the 
text string whose font you want to 
change. 
The character cursor appears in the text 
string. 
Alternatively, at the toolbar click , 
then click the text string whose font 
you want to change. 
Points appear around the text string. 

 From the [Format] menu, select [Font]. 
The [Font Select] dialog box appears. 

 Clicking a font name displays the text 
in the preview field with the font you 
chose, allowing you to find the font 
you want. 

 After you have selected the font you want, click [OK]. 

In the [Font Select] dialog box, font names that start with "Plot" are stroke fonts. 

 p. 24, "Stroke Fonts" 

Engraving area

Points

Character cursor

PreviewClick a font name. 
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Working with Text Strings

You can resize and deform a text string by manipulating the points displayed around the string. 

Resizing and Moving
At the toolbar, click , then click the text string. Points appear around the text string. 
 You can change the size of the text string by lining up the pointer with a point and dragging. 
 You can change the size while keeping the vertical/horizontal aspect unchanged by holding down the [Shift] key on the  

keyboard as you drag the point ( ). 
 You can move a text string by placing the pointer inside the area bounded by the points and dragging. 

Rotating Text, Italic Text, and Changing the Character Pitch

When a text string is displayed with 
points, clicking the text string changes 
the appearance of the points. 

 You can rotate a text string by lining up the pointer with a point ( ) and dragging. 
 You can also make a text string italic, or change the character or line pitch.
 To hide points, click in the area outside the points.

When there are two or more lines of text strings, this 
point is displayed. Drag it to change the line pitch. 

You can change the size by dragging. 

You can change 
the horizontal size 
by dragging. 

You can change the vertical 
size by dragging. 

To move, place the pointer 
in the area inside the points 
and drag. 

Drag to rotate. 

Drag to make italic. 

Drag to change the 
text pitch. 
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Text-string Settings

You can specify numerical value for rotation, slanting, character pitch, and so on in a dialog box. 

 At the toolbar, click , then click the text string. 
The character cursor appears in the text string. 
Alternatively, at the toolbar click , then click the text string. 
Points appear around the text string.

 From the [Format] menu, select [Properties]. 
The [Text string Properties] dialog box appears. 

 Changing the settings for any of the 
items updates the settings for the text 
shown in the preview field. 

 When you have finished making the settings, click [OK].

Filling a Text String

If the Fill setting is not made, only the outlines of characters are engraved. 
When the Fill setting is made, the interiors of characters are all engraved by flat-dragging. 

 At the toolbar, click , then click the text string. 
The character cursor appears in the text string. 
Alternatively, at the toolbar click , then click the text string. 
Points appear around the text string. 

 At the toolbar, click . 
Alternatively, from the [Shape] menu, select [Fill]. 
The [Fill Setup] dialog box appears. 

 Click [Fill] to select the check box. 
[Pitch] is the engraving spacing of the cutter. 
When you're using the included cutter, set 
this to [0.1]. 

 When you have finished making the 
settings, click [OK]. 
Pitch lines appear in the characters. The cut-
ter moves along these lines as it engraves. 

You can change the character boldness. 

When you click this to select the check box, flat-drag engraving 
of the interiors of the character outlines is performed, then the 
contour lines of the characters are engraved. 

You can specify colors and vary 
the engraving depth for each color. 

Enlarged area
Click  on the toolbar to make the pointer change to , then click 
the location where you want to zoom in. Right-click to zoom out. 

The spacing of these 
lines is the pitch. 
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Stroke Fonts

You can change text to stroke fonts and carry out engraving. Line width when engraving varies according to the cutter width 
and engraving depth. 

 At the toolbar, click , then click the text string. 
The character cursor appears in the text string. 
Alternatively, at the toolbar click , then click the text string. 
Points appear around the text string.

 At the toolbar, click . 
Alternatively, from the [Format] menu, select [Make Stroke]. 
The [Select Stroke Font] dialog box appears. 

 Click the drop-down arrow to display the menu, then select a stroke font. 

 After you have selected the font you want, click [OK]. 

Converting to Polygons

You can convert text strings to graphic shapes (polygons). This makes it possible for you to modify the shape of characters, 
to create logos, for example. 

 At the toolbar, click , then click the text string. 
The character cursor appears in the text string. 
Alternatively, at the toolbar click , then click the text string. 
Points appear around the text string. 

 From the [Shape] menu, select [Con-
vert to Polygon]. 
The text string is convert to a shape. 

 When the text string is displayed with points, clicking  on the toolbar displays points at 
the vertices of the polygon. 
Alternatively, click   on the toolbar, then click the polygon. 
Points appear at the vertices of the polygon. 

 You can change the shape by drag-
ging the points. 
You can also insert and cut away ver-
tices by moving the pointer to a line or 
point and right-clicking. 

In the [Font Select] dialog box as well, you can specify a stroke font by selecting a font whose name starts with 
"Plot." 

 P. 21, "Selecting the Font" 

Example of Converting a Stroke Font to a Polygon

This menu appears when 
you move the pointer to a 
line or point, then right-click. 

Stroke font
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Saving Data

Save the data you have created to a hard disk or the like. 

 At the toolbar, click . Alternatively, go to the [File] menu and select [Save As]. 
The [Save As] dialog box appears. 

 Specify the information for [Save in] 
and [File Name], then click [Save]. 

Setting the Cutting Parameters

Before you carry out engraving, adjust the Speed control and Spindle Speed control on the switch panel of the EGX-20. 

When you're performing engraving for the first time, set the Speed control at the 
central position and the Spindle Speed control at its maximum setting. 

Also, if you're using acrylic material and the included blade, then you may leave the 
settings for the EGX-20 driver at their default values. 

Go ahead and try engraving using these settings. 
In some cases it may not be possible to perform engraving smoothly. In such cases, ex-
amine the engraving results and adjust the settings for the cutting parameters, repeat-
ing this process of trial and adjustment until you obtain good engraving results. 

General Suggestions for Making Adjustments

Depending on the engraving results, make the settings as described below. Use the Speed control and the Spindle Speed 
control to make the adjustments. 

•	 If	engraved	places	are	rough	(not	smooth),	then	lower	the	speed.	
•	 If	the	material	melts	or	suffers	burring,	lower	the	spindle	speed.	
•	 If	the	spindle	speed	is	too	fast,	the	material	may	melt.	Lower	the	spindle	speed.	Also,	if	there	is	buildup	of	melted	cuttings	

in engraved grooves, you may be able to remove them by scrubbing with a toothbrush or the like. 
•	 Increasing	the	spindle	speed	when	using	a	narrower	blade	and	reducing	it	when	using	a	thicker	blade	may	produce	

better results. 
•	 In	many	cases,	slower	speeds	produce	attractive	finished	results,	but	a	speed	that	is	too	slow	may	cause	melting.	

Make the following adjustments with the driver. 

	•	 The	default	engraving	depth	is	0.1	mm.	You	can	engrave	at	a	greater	depth	by	changing	the	value	for	the	driver	setting	[Z	
Down Position]. The maximum depth at which you can engrave is 1.0 mm. (In the driver, you make the setting by specify-
ing a value prefixed by a minus sign ["-"].) A greater engraving depth yields correspondingly wider lines. This means that 
text characters also become thicker. 

•	 If	the	engraving	depth	is	too	deep,	it	may	not	be	possible	to	obtain	attractive	results	even	when	the	speed	and	spindle	
speed are adjusted. 

•	 One	method	for	obtaining	engraving	results	that	are	attractive	yet	deep	is	to	perform	the	same	engraving	twice.	(For	
example, setting [Z Down Position] to -0.18 mm and [Z Cutting Pitch] to 0.10 mm results in engraving in two passes, to 
a depth of 0.18 mm. ) 

•	 Leave	[Z	Up	Position]	set	to	0.50	mm	at	all	times.	Lower	values	result	in	less	wasted	movement.	
•	 You can obtain attractive engraving results by setting [Fill Pitch] to 80% or less than the width of the cutter -- actually at about 

50%. 
 P. 23, "Filling a Text String" 

At the central 
position

At maximum
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Adjusting the Driver Settings

Follow the steps below to set the cutting parameters for the driver. 

 In Dr. Engrave, from the [File] menu, select [Print Setup]. 
The [Print Setup] dialog box appears. 

 Make sure the printer name is set to 
[Roland EGX-20] (if the printer name 
is not [Roland EGX-20], then click the 
drop-down arrow and select [Roland 
EGX-20]), then click [Properties]. 
The [Roland EGX-20 on LPT1: Properties] 
dialog box appears. 

 Click the [Tool] tab.
The [Tool] page appears. 

 Change the values for items that need 
to be adjusted, then click [OK]. 

 To return to the [Print Setup] dialog box, click [OK]. 

Clicking  at the upper right of the dialog box changes the pointer to , which you can then use to click an 
item you want to learn about in detail. A detailed explanation appears.
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Performing Engraving

Now Let's try engraving a name on a plate. If the View light on the EGX-20 is illuminated, press the View button to make the 
View light go dark. 

 At the toolbar, click . Alternatively, go to the [File] menu and select [Print]. 
The [Print Setup] dialog box appears. 

 Make sure the printer name is set to [Roland EGX-20] (if the printer name is not [Roland 
EGX-20], then click the drop-down arrow and select [Roland EGX-20]), then click [OK].
Cutting starts.
When engraving ends, the spindle unit rises all the way to the top and stops there. 

 Then, remove the material, press the View button. 
The carriage moves to the right edge and the table moves to the front, allowing you to detach the mate-
rial from the adhesive sheet. 
Use a toothbrush or the like to carefully brush away any buildup of cuttings on the material or the adhesive 
sheet. Also, use a vacuum cleaner to carefully clean away any cuttings remaining on the EGX-20. 

Emergency Stop

If some problem occurs while engraving is in progress and you want to stop the EGX-20, follow the steps below. 

 Press the power button on the switch panel. 
If there is a printer icon on the taskbar in Windows, double-click the icon. 

 The progress of printing is displayed. Delete the document. 

If the characters of the text are large and thick, attach the large nose cone.

 P. 39, "Using Different Nose Cones for Different Purposes" 

 Before You Detach the Material
When engraving ends, don't do anything yet. Before you remove the material, clean away cuttings and carefully 
inspect the finished results. If the engraved surface is rough or uncut areas remain, try performing cutting a second 
time, leaving the material set up as it is. That is, carry out exactly the same engraving once more on the finished 
plate. Keep in mind that as long as you don't detach the material, you can perform finishing again if the first pass 
was not a complete success.
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4  Creating a Relief (3D Cutting Mode)

This section describes the basic sequence of operations for creating reliefs an other three-dimensional objects. If you want 
finished results of even higher quality, also see "Using the 3D Cutting Mode" on page 40. 

Removing the Cutter

If a cutter is installed, then remove the cutter first. 

 Open the cover for the carriage. 

 Use the included hexagonal screw-
driver to loosen the retaining screw 
for the cutter holder. 

 Grasp the top of the cutter and pull it 
up and out. 

NOTICE
Cuttable depth is 0.05 to 7 mm (0.002 to 0.27 in.) in the 3D Cutting mode. Do not attempt cutting that exceeds 
this depth. 

The screw is attached to the cutter holder in 
such a way that it can be loosened but not 
detached completely. The screw is attached to 
the cutter holder in such a way that it can be 
loosened but not detached completely. 
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Detaching the Depth Regulator Unit

 If the EGX-20 is switched off, press the power but-
ton to turn it on. 
The carriage moves to the right edge and the table moves 
to the front, the unit goes into View status, and the Power 
and View lights light up. 
If the EGX-20 is turned on but the View light is not 
illuminated, press the View button. 
The carriage moves to the right edge and the table moves 
to the front, the unit goes into View status, and the Power 
and View lights light up. 

 Press the power button to switch off the power. 

 Open the cover for the carriage. 

 Open the cover for the carriage. 

 Use the included small hexagonal 
wrench to loosen the screw. 
When you do this, support the depth regu-
lator unit with your hand to keep it from 
falling. 

To install the depth regulator unit, pass a pin 
through the hole insert the unit as far as it will 
go, then tighten the screw.
Store the depth regulator unit in a safe place 
to guard against losing it. 

When you switch on the EGX-20, a sensor checks whether the depth regulator unit is installed. At this time, the 
machine goes into the Engraving mode if the depth regulator unit is install and the 3D Cutting mode if it is not 
installed. 

Power and View 
lights illuminate.

Screw

Depth regulator unit

The cover for the carriage. 

Pin

294  Creating a Relief (3D Cutting Mode)



Installing a Cutter

In the 3D Cutting mode, you install a cutter before you load material. 

 Press the power button to turn on the power. 
The carriage moves to the right edge and the table moves to the front, the unit goes into View status, and 
the Power and View lights light up. 

 Press the View button. 
The spindle unit and table move, and the spindle unit moves to above the origin point on the table. 
When movement ends, the View light goes dark. 

 Use the movement button on the switch panel to 
move the spindle unit to about the center of the 
table.

 Press and hold the center of the movement button 
for a short while (0.6 second or more). 
The Z-axis light illuminates, indicating that it is now possible 
to move the spindle unit up and down.

 Press the lower part of the movement button. 
The spindle unit descends while you hold down the button. 
Hold down the movement button until the spindle unit 
stops automatically. 

The spindle unit stops, 
leaving a small gap. 

Press up, down, or 
to the left or right. 

Press. 

Press. 
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 Insert the cutter into the hole in the 
cutter holder, then slowly lower the 
cutter. 
Lower it until the cutter touches the adhe-
sive sheet. 

 Use the included hexagonal wrench 
to tighten the retaining screw for the 
cutter holder and secure the cutter in 
place. 

Loading Material

You use the included adhesive sheet to secure material to engrave to the table on the EGX-20. 

 If the View light is dark, then press the View button. 
The carriage moves to the right edge and the table moves to the front, the unit goes into View status, and 
the Power and View lights light up. 

NOTICE
Before you load material, attach the included adhesive sheet. Be sure the unit is in View status when loading 
material. 

 P. 10, "Attaching the Adhesive Sheet" 
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 Place a piece of material on the adhe-
sive sheet, then press down on it from 
above to anchor it securely. 
You can place the item anywhere on the ad-
hesive sheet. However, if the plate is placed 
at an angle with respect to the table, the 
engraving will not be straight. Place it so 
that it is aligned straight with the corners 
and sides of the table. 

Setting the Origin Point

When loading material or installing a cutter, be sure to set the origin point. 
The origin point is the reference point for engraving. You set it individually for each piece of material you load. 
In the 3D Cutting mode, you separately set the origin point for the vertical and horizontal position of the material and the 
origin point for the height (thickness). 
Omitting this operation may result in locations other than the material being engraved. 

Setting the Height Origin Point

 Refer to "Basic Steps for Moving the Spindle Unit" on page 19 and move the spindle unit 
as described below. 
1.  Move the spindle unit to position it at the center of the material. 
2.  Move the spindle unit downward until the cutter is nearly touching the surface of the 
material. 

 Loosen the retaining screw for the cut-
ter holder and move the cutter until it 
touches the material. 
When the cutter is touching the ma-
terial, tighten the retaining screw for 
the cutter holder to secure the cutter 
in place. 

Place the plate on the adhesive sheet, then press 
down on it from above to anchor it securely. 

Loosen the retaining screw for the cutter holder and 
move the cutter until it touches the material. 
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 Make sure the Z-axis light on the switch panel is illuminated, then press and hold the Origin 
Set button for a short while (0.3 second or more). 
(Pressing the Origin Set button lights the Origin Set light. Make sure the light is illuminated, then release 
the button. The Origin Set light goes dark.) 

Setting the Origin Point for the Vertical and Horizontal Position

 Refer to "Basic Steps for Moving the 
Spindle Unit" on page 19 and move 
the spindle unit so that the cutter is 
positioned above the lower left corner 
of the material. 
 Lower the spindle unit to check 
whether the cutter is at the lower left 
corner. 

 If the Z-axis light on the switch panel is illuminated, press and hold the center of the move-
ment button for a short while (0.6 second or more). 
Make sure the Z-axis light is dark, then press and hold the Origin Set button for a short 
while (0.3 second or more). 
(Pressing the Origin Set button lights the Origin Set light. Make sure the light is illuminated, then release 
the button. The Origin Set light goes dark.) 

You can set the height origin point by pressing the Origin Set button when the Z-axis light is illuminated. 

You can set the origin point for the vertical and horizontal position by pressing the Origin Set button when the 
Z-axis light is dark. 

Material

Move the cutter to this location.
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Creating Data with 3D Engrave

This section describes the basic steps for cutting a relief using 3D Engrave. 
3D Engrave is a program for adding thickness to a flat (two-dimensional) graphic to create a relief (raised engraving). 
You can also add thickness to figures and other images. 

Starting 3D Engrave

In Windows, click the [Start] button. At 
the Start menu, point to [Programs], 
then to [Roland 3D Engrave]. At the 
menu that appears, click [3D En-
grave]. 
3D Engrave starts. 

Selecting the Driver

Select the output device (driver). Even if you click [Properties] and make sets for the size of the material or the cutting condi-
tions (tool speed, depth, and so on), the data that is output is not affected. 

 In 3D Engrave, go to the [File] menu and select [Output Device Setup]. 
The [Print Setup] dialog box appears. 

 Make sure the printer name is set to 
[Roland EGX-20] (if the printer name 
is not [Roland EGX-20], then click the 
drop-down arrow and select [Roland 
EGX-20]), then click [OK]. 

Selecting the Model

Select the model name. This generates a tool path matched to the selected model. 

 In 3D Engrave, go to the [Cut] menu and choose [Machines]. 
The [Model Selection] dialog box appears. 

 Select [EGX-20], then click [OK]. 

The following explanation is for Windows 95/98/Me. For an explanation for Windows NT 4.0/2000/XP, or for a more 
detailed explanation, see the help for 3D Engrave or refer to the 3D Engrave User's Manual (PDF) on the Roland 
Software 
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Specifying the Size of the Relief

 In 3D Engrave, go to the [Relief] menu and select [Relief Size]. 
The [Relief Size] dialog box appears. 

 For Size, type in the size values for the 
relief in the [Vertical] and [Horizontal] 
entry boxes, and in [Resolution], enter 
the degree of detail. Then click [OK]. 

The relief area is displayed. The relief area is 
where you design the relief. 
The screen displayed at this time is called the 
"2D screen." It's the screen for typing in text 
and creating shapes.

Creating Shapes and Text

To create shapes and text, you click 
the shape-drawing buttons and drag 
in the relief area. 
To type in text, click the  button, then 
click inside the relief area. When the 
character cursor appears, type in the 
text from  the keyboard. 
To change the size of shapes or text, refer to 
"Working with Text Strings" on page 22. 

Creating a Raised Engraving (Relief)

Add thickness to shapes and text to create a relief.

 Click the shape or text string you want for adding thickness to select it.

 Click the  button. 
The [Create Relief ] dialog box appears. 
The dialog box may differ depending on the 
type of object you selected. The window 
shown left is the dialog box that appears 
when you are creating a shape or text. 
Make the settings for the items re-
quired to create the relief, then click 
[OK]. 

Relief area of the 2D screen

Shape-drawing 
buttons

* The maximum cutting height is 7 mm (0.27 in.). 
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The shape of the relief is displayed as a three-
dimensional solid. 
This window is called the "3D screen." It displays 
the shape of the relief and the tool path. You 
cannot edit shapes or text.

Generating the Tool Path

A tool path is the path followed by the tool's blade tip. The tool path is generated from the cutting parameters that are pres-
ently set. Before you create the tool path, make the settings for the cutting parameters. At the cutting parameters, make the 
settings for the composition of the workpiece, the type of tool, and the cutting process.

 From the [Cut] menu, select [Cutting 
Parameters]. 
The [Cutting Parameters] dialog box ap-
pears. 
Make the settings for the necessary 
items for cutting, then click [OK]. 

  Click the  button. When the tool 
path is created, it appears in pink on 
the 3D screen.

Draft Cutting and Finishing
Cutting has two processes: draft cutting and finishing. You first create the tool path for draft cutting and carry out 
cutting. After draft cutting ends, go back to this step, create the tool path for finishing and perform cutting again. 
Be sure never to perform finishing on material that has not undergone draft cutting.

* The blade angle of the general-use cutter is [30] degrees. 
* If you're using a flat cutter, select [Square end mill]. 
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Checking the Cutting Results

If Virtual MODELA is installed and set up, then before you perform cutting you can check the shape that will be produced 
after cutting on the screen. 

From the [File] menu, choose [Output 
Preview]. 
Virtual MODELA starts. The 3D Engrave cut-
ting data is imported into Virtual MODELA. 
An animated display of tool movement ap-
pears, and the shape after cutting is gradu-
ally produced. 

Saving Data

Save the data you have created to a hard disk or the like. 

 At the toolbar, click . 
Alternatively, go to the [File] menu and select [Save As]. 
The [Save As] dialog box appears. 

 Specify the information for [Save in] and [File Name], then click [Save]. 

Adjusting Cutting

Before you carry out engraving, adjust the Speed control and Spindle Speed control on the switch panel of the EGX-20. 

When you're performing cutting for the first time, set the Speed control at the central 
position and the Spindle Speed control at its maximum setting. 

Also, 3D cutting may use materials such as modeling wax that differ from the material 
used for nameplate engraving. In such cases it may also be necessary to change the 
cutter to match the composition of the material. 
You need to set cutting parameters that match such changes in the material and the 
cutter. First, test cutting using a small relief. If smooth cutting is not possible, then 
adjust the settings for the cutting parameters. Repeat this process until smooth cut-
ting is achieved. 

General Suggestions for Making Adjustments

Depending on the cutting results, make the settings as described below. Use the Speed control and the Spindle Speed 
control to make the adjustments. 

•	 If	cut	places	are	rough	(not	smooth),	then	lower	the	speed.	
•	 If	the	material	melts	or	suffers	burring,	lower	the	spindle	speed.	
•	 If	the	spindle	speed	is	too	fast,	the	material	may	melt.	Lower	the	spindle	speed.	Also,	if	there	is	buildup	of	melted	cuttings	

in engraved grooves, you may be able to remove them by scrubbing with a toothbrush or the like. 
•	 Increasing	the	spindle	speed	when	using	a	narrower	cutter	and	reducing	it	when	using	a	thicker	cutter	may	produce	

better results. 
•	 In	many	cases,	slower	speeds	produce	attractive	finished	results,	but	a	speed	that	is	too	slow	may	cause	melting.	

At the central 
position

At maximum
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Performing Cutting

Now let's try cutting a relief. If the View light on the EGX-20 is illuminated, press the View button to make the View light go 
dark. 

 At the toolbar, click . 
Alternatively, go to the [File] menu and select [Output]. 

 A dialog box with the prompt "Start 
cutting." appears. Click [OK]. 
Cutting starts. 
When cutting ends, the spindle unit rises 
all the way to the top and stops at that 
position. 

If you carried out draft cutting, then go back to "Generating the Tool Path" on page 36 and perform finish-
ing. Be sure not to remove the material at this time. 
When finishing cutting ends, remove the material. Pressing the View button moves the carriage to the right 
edge and moves the table to the front, allowing you to detach the material from the adhesive sheet. 
Use a toothbrush or the like to carefully brush away any buildup of cuttings on the material or the adhe-
sive sheet. 
Also, use a vacuum cleaner to carefully clean away any cuttings remaining on the EGX-20. 

Emergency Stop

If some problem occurs while cutting is in progress and you want to stop the EGX-20, follow the steps below. 

 Press the power button on the switch panel. 

 If there is a printer icon on the taskbar in Windows, double-click the icon. 
The progress of printing is displayed. Delete the document. 
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5  More Advanced Operations

Using Different Nose Cones for Different Purposes

The machine comes with three types of nose cones, one large, one medium, and one small. For engraving general items 
such as nameplates, you use the medium-size one already installed in the machine. Use the large- and small-size ones in 
cases like following.

Large-size
You use this one when characters are large and the fill width is broad. In the engraving mode, fill operations whose width is 
broader than the diameter of the nose cone cannot be performed. Make sure that the nose cone does not become snagged 
on differences in levels.

Small-size
In the engraving mode, you can engrave even cylindrical and curved objects. Using the small-size nose cone in such cases 
can produce attractive finished results. Note, however, that the greater is the amount of curvature (that is, the more acute is 
the angle of the surface), the shallow is the engraving. Also, the flat cutter cannot be used with the small-size nose cone.

Changing the Nose Cone

To change the nose cone, first detach the depth regulator unit. 
 p. 29, "Detaching the Depth Regulator Unit"

Large amount of curvature 

Medium or smallLarge

Large Small

Attaching Detaching
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Using the 3D Cutting Mode

This section introduces some advanced techniques for using the 3D cutting mode more fully. Try them out in situations like 
the following. 

Performing a special engraving operation
This includes times when you want to do something like performing fill engraving over a width that is broader than the 
diameter of the nose cone, or engraving the entire surface of an irregularly shaped (that is, non-rectangular) plate. Note, 
however, that the thickness of the plate must be uniform. 

Creating a relief with a higher-quality finish 
When creating a relief, there may be minute fluctuations in the uniformity of the finished thickness, or there may be slight 
uncut areas. You can eliminate such problems.

This requires a preparatory operation called "surfacing."

What Is Surfacing? 

Surfacing is an operation that cuts the entire surface of the table to obtain a level finish. However, because you cannot cut 
the table directly, the process involves attaching an acrylic panel or the like and cutting the surface of the panel instead. The 
precision of the surface produced in this way is sufficient to obtain a uniform cutting-in depth in the 3D cutting mode. You 
attach the material to the top of the surfaced acrylic panel. 

Requirements for Surfacing 

Have the following items available. Also, you use the included Dr. Engrave program. 

Plastic panel (acrylic or the like) 
Size: 203.2 x 152.4 mm (8 x 6 in.) 
Thickness: 2 mm (0.08 in.) or more,  up to about 10 to 15 mm (0.4 to 0.6 in.) 
Must be flat with no warping 

Cutter 
Roland DG ZEC-A2320 (flat cutter, blade width 3.175 mm) 

Double-sided tape 
Must be thin 

Performing Surfacing 

Perform cutting in the 3D cutting mode. For information on such matters as how to install the cutter and set the origin point, 
refer to "4. Creating a Relief (3D Cutting Mode)." Note that the thickness of the material that you can mount is reduced by an 
amount equal to the thickness of the attached panel. 
It takes about four hours to finish cutting the entire surface of the panel (for acrylic). 
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grave, in the [Program Files] - [Dr.Engrave] - [samples] folder. 

8.
At the Dr. Engrave [File] menu, select [Print Setup], 
then select [EGX-20]. Click [Properties]. 
9.
Make the settings for cutting parameters such as 
[Engraving Area] and [Material] as follows, then click 
[OK]. 
[Engraving Area]:
Width 203.2 mm (8 in.), length 152.4 mm (6 in.) 
[Material]:
The composition of the attached panel ([Acrylic] or the like) 
[Z Down Position]:
 -1 mm

10.
Set the machine's Speed control at its central posi-
tion and the Spindle Speed control at the maximum 
setting. 

11.
At the Dr. Engrave [File] menu, select [Print], then 
click [OK]. 
Surfacing starts. 

1.
Follow the procedure in "4. Creating a Relief (3D 
Cutting Mode)" to detach the depth regulator unit and 
install the cutter (ZEC-A2320). 
2.
Use the double-sided tape to attach the acrylic panel 
to the table securely. 
Align the corners of the panel with the holes at the four corners 
of the table. Attach the panel securely so that it does not slip 
or come loose. 

3.
Lower the cutter to a height about 1 mm (0.04 in.) from 
the surface of the panel. 

4.
Move the cutter to each of the four corners of the panel 
(A through D) to determine the corner where the clear-
ance is the smallest. 
If this is difficult to determine, try slipping a stack of several 
sheets of paper in the gap between the cutter and the panel. Use 
the number of sheets of paper that can pass through the gap as 
an indicator for determining the amount of clearance. 

5.
Move the cutter to the corner that you determined in 
step 4 to have the smallest clearance, and make the 
setting for the height origin point at the surface of the 
panel. 
6.
Move the cutter all the way to the front left of the table 
and make the setting for the origin point for the vertical 
and horizontal dimensions at that location. 
7.
Start the included Dr. Engrave program and open the 
attached "sample1.ded" file. 
The sample1.ded file is on the drive where you installed Dr. En-

Table

Acrylic panel

Speed control

Spindle 
Speed control

About 1mm
(0.04 in)

Cutter

Acrylic panel

Clearance
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6  Optional Parts

Replacement Cutters and Consumable Parts

The following replacement blades and consumable parts are available. 

Replacement Cutters

 General-purpose (general-purpose cutters suitable for engraving acrylic and plastic plates)
(Blade width)

• ZEC-A2013 0.127 mm

• ZEC-A2025 0.254 mm (* This is the originally included blade.) 

• ZEC-A2051 0.508 mm

• ZEC-A2076 0.762 mm

 Flat cutter (blades having a wider tip than general-purpose cutters)
(Blade width)

• ZEC-A2105 1.52 mm

• ZEC-A2190 1.91 mm

• ZEC-A2230 2.29 mm

• ZEC-A2320 3.175 mm

 Quarter-round types (having a larger tip pocket than general-purpose cutters, and suited to  engraving 
soft material at high speed)

(Blade width)

• ZEC-A2013-QR 0.13 mm

• ZEC-A2025-QR 0.25 mm

Adhesive Sheet
• AS-10 10 sheets

Replacement Parts
• ZM-12 Spindle-motor unit (with a belt and a pulley)

* As a general guide, we recommend replacing this after 
every 1,000 hours. 

• ZS-20 Spindle unit
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Optional Parts for Scribing

These are optional items for scribing. Use the burnishing attachment and the diamond scraper together as a set.

• ZB-20 Burnishing attachment

• ZDC-A2000 Diamond scraper

To Perform Scribing

Scribing is a form of engraving that involves scraping the workpiece. The spindle is not rotated. This does not perform deep 
cutting-in, but it produces an engraving with a distinctive texture and little burring. It is suited for use with light metals such 
as aluminum or brass plates. 

1. Installation
To perform scribing, use the 3D cutting mode. Remove the depth regulator unit. Also detach the cutter holder and install 
the burnishing attachment instead. 
The methods for attaching the diamond scraper and setting the origin point are the same as for an ordinary tool. Follow the 
same procedure as for use in 3D cutting mode. 

2. Program Operation 
Program operation is similar to the procedure for creating a nameplate. Use Dr. Engrave. 
For the cutting parameters set using the driver, make the following settings at the printer-setting [Properties] page. 

[Tool] 
1. For [Material], select [Scribing]. 
2. For [Z Down Position], enter -5 mm, and for [Z Engraving Pitch], enter 5 mm. 

[Options] 
Select the [Engrave with Spindle OFF] check box to make the setting for performing engraving without rotating the 
spindle.
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7  Appendix

Daily Care and Maintenance

 Use a vacuum cleaner to carefully clean away cutting dust. 
 Use a toothbrush or the like to remove cuttings from the adhesive sheet. 
 Do not use an air blower or the like to blow away cutting dust. The cuttings may get inside the machine and cause 

breakdown. 
 Use a dry or well wrung-out cloth to wipe clean. Do not use solvents such as thinner or alcohol. 
 Lubrication is not required. Improper application of grease or the like may actually lead to breakdown and should not 

be attempted. 

Functions Using the Switch Panel on the EGX-20

In addition to the usual operations using the switch panel, you can also use the switch panel to carry out operations like the 
ones described below. 
Carry out the following operations with the power to the EGX-20 switched off and the EGX-20 disconnected from the AC 
adapter. 

Displaying the Working Time of the Spindle Motor
During normal operation, if the Z-axis light flashes slowly for ten seconds (four or five flashes) when you turn on the power, 
it means the spindle motor has been powered up for over 1,000 hours. 
The spindle motor is a consumable part. As a general guide, we recommend replacing it after every 1,000 hours. 
You can also use the following procedure to check the number of hours that the spindle motor has been powered. 

1. While holding down the View button on the switch panel, insert the AC adapter into the EGX-20.   
The illumination and flashing of the Z-axis light, Power light, View light, and Origin Set light show how many hours the unit 
has been powered up. 
2. After you have verified the time, press the View button. This switched off the power. 

Less than 250 
hours

Less than 500 
hours

Less than 750 
hours

Less than 1,000 
hours

1,000 hours or 
more

Z-axis light      Slow flashing
Power light – – –  
View light – –   
Origin Set light –    

 : Illuminated    – : Dark      : Flashing

Resetting the Working Time of the Spindle Motor
When you have replaced the spindle motor with a new motor, follow the steps below. 
 While holding down the power and View buttons on the switch panel, insert the AC adapter into the EGX-20.   

The View light illuminates and the powered time of the spindle motor is reset. 

Setting the Origin Point to Its Default Value (the Lower Left Corner)
 While holding down the Origin Set button on the switch panel, insert the AC adapter into the EGX-20.   

The Origin Set light illuminates and the origin point is set to its default (at the lower left corner). 

Setting the Origin Point at the Center of the Table
 While holding down the center of the movement button on the switch panel, insert the AC adapter into the EGX-20.  

The Z-axis light illuminates and the origin point is set at the center of the table. 

44 7  Appendix



What to Do If...

The power switch doesn't turn on the power. 

 Disconnect the AC adapter from the machine, reconnect it, then turn on the power. 

The power switch doesn't turn off the power. 

 Disconnect the AC adapter from the machine. 

The power light flashes every 0.25 seconds, and the machine operations strangely or not 
at all. 

 Incorrect data has been sent. Check whether an incorrect printer driver has been selected. Also check for faulty cable 
connections and the like. 

The power light flashes once a second and the machine stops. 

 The load is excessive. You can resume operation by pressing the View button, but if operation stops again, make the 
cutting parameters less demanding, such as by using a slower speed. If the problem occurs frequently, the cutter or the 
spindle motor may have reached the end of their service life. 

The Z-axis light flashes for ten seconds. 

 The usage time of the spindle motor has exceeded 1,000 hours. The spindle motor is a consumable part. As a general 
guide, we recommend replacing it after every 1,000 hours. 

All the lights flash and the machine doesn't operate. 

 Disconnect the AC adapter from the machine, reconnect it, then turn on the power. 

The depth gradually changes during engraving. 

 This can be caused by large changes in temperature due to a heater or the like. Wait for the temperature to stabilize, then 
reinstall the blade. 

The depth is uneven or unattractive. 

 The installed cutter may be loose. Tighten securely using the hexagonal screwdriver. Also tighten the cutter holder securely. 
(The cutter holder is reverse-threaded, so turn counterclockwise to tighten.) 

Some portions were not engraved.

 This happens when the nose cone is lifted up by a burr and momentarily loses contact with the material. Adjust the cut-
ting parameters so that no burrs are formed.

 If some areas are unengraved, try performing cutting a second time. This means performing exactly the same engrav-
ing one more time, without detaching the material. Before you perform engraving the second time, be sure to carefully 
clean away any cuttings.

The actual depth is completely different from the set depth. 

 Is the depth regulator unit installed? Was installation or removal of the depth regulator unit carried out with the power 
off? When you turn on the power after installing or removing the depth regulator unit, the machine automatically changes 
to the Engraving mode or the 3D Cutting mode. 
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A screeching sound is heard and engraving takes place at a strange location or is mis-
aligned. 

 The machine lost its positioning, possibly because the material became caught on something. Reset the power and redo 
the operation from the beginning. The nose cone cannot go beyond differences in level, so go into [Print Setup] and set 
the cutting area to a suitable value to prevent movement beyond the edges of the material. 

 It is possible that excessive buildup of cuttings has occurred, and some cuttings have gotten inside the machine. Cleaning 
thoroughly using a vacuum cleaner or the like. Cleaning should be performed carefully. 

 If the problem persists, a breakdown may have occurred. Contact your authorized Roland DG Corp. dealer or service 
center. 

No engraving is performed when data is sent from the computer. 

 If the View light is illuminated, it means that operation is paused. Press the View button to release it. 
 The origin point is too far toward the back or right side of the table. Set the origin point again. 

The spindle motor does not turn. 

 In the [Properties] dialog box of the printer setting, on the [Options] page, there is a setting called [Engrave with spindle 
motor stopped]. Check this. 

 Applying lubrication may lead to buildup of cuttings that then hardens. Clean away using a brush or the like. 
 The spindle motor may have reached the end of its service life. The spindle motor is a consumable part. As a general guide, 

we recommend replacing it after every 1,000 hours. 

Part of the carriage strikes the material while in the 3D Cutting mode. 

 The maximum cutting depth when in the 3D Cutting mode is 7 mm. Check whether you are attempting to create a relief 
larger than this. 

The cutter holder cannot be removed. 

 The cutter holder is reverse-threaded. Turn it clockwise to remove it.

The View light is not illuminated when switching the power on.

 Switch off the power to the EGX-20. Rotate the part in the figure counterclockwise a few turns. Switch on the power, and 
make sure whether the View light illuminates.  

Carriage

Spindle motorSpindle unit
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Specifications

Main Unit Specifications

Table size 220 (W) x 170 (D) mm (8-5/8 (W) x 6-11/16 (D) in.)

Table load weight Maximum 1 kg (2.2 1b.)

Carriage cutting range 203.2 (X) x 152.4 (Y) x 31.8 (Z) mm (8 (X) x 6 (Y) x 1-1/4 (Z) in.)

C a r r i a g e  o p e r a t i n g 
speed

X and Y axes: 0.1 to 1 mm/s, 1 to 15 mm/s (0.0039 to 0.59 in./s)
Z axis: 0.1 to 1 mm/s, 1 to 6 mm/s (0.0039 to 0.23 in./s)

Cutting-depth control AST (Active Surface Tracking) system

Cuttable depth 3D Cutting mode: 0.05 to 7 mm (0.002 to 0.27 in.)
Engraving mode: 0.05 to 1 mm (0.002 to 0.039 in.)

Cuttable material Composition: Resin (acrylic, modeling wax, ABS, polyacetal, polycarbonate, styrenefoam, 
etc.), wood, and plaster
Maximum thickness: 30 mm (1-1/8 in.)

Resolution 0.01 mm/step (0.00039 in./step)

Spindle motor 12 W (DC motor)

Spindle rotating speed 4,000 to 15,000 rpm

Overload detection fea-
ture

Yes

Cutter diameter 3.175 mm (1/8 in.)

Interface Parallel (compliant with IEEE 1284)

Buttons and controls Movement button (joystick type), Power button, View button, Origin Set button, Speed 
control, and Spindle Speed control

Indicators Z-axis light, Power light, View light, and Origin Set light

Power supply Dedicated AC adapter
Input: AC 100 to 240 V ±10%, 50/60 Hz
Output: DC 19 V, 2.1 A

Power consumption Maximum during operation: 0.6 A at 100 V, 0.27 A at 240 V

Operating noise level Standby: Less than 45 dB (A)
No-load operation: Less than 70 dB (A) (according to ISO 7779)

External dimensions 515.2 (W) x 368.3 (D) x 270.6 (H) mm (20-5/16 (W) x 14-1/2 (D) x 10-5/8 (H) in.)

Machine weight 10.9 kg (24 1b.)

Packed dimensions 673 (W) x 518 (D) x 412 (H) mm (26-1/2 (W) x 20-3/8 (D) x16-1/4 (H) in.)

Packed weight 15.5 kg (34.2 1b.)

Operating environment Temperature: 5 to 40 ºC (41 to 104 ºF)
Relative humidity: 35 to 80% (no condensation)

Included items AC adapter, power cord, cutter, cutter holder, nose cones (large, medium and small), 
adhesive sheet, test-use plate material, hexagonal screwdriver, hexagonal wrenches 
(large and small), Roland Software Package, User's Manual 

Parallel Interface Specifications

Rating Compliant with IEEE 1284: Nibble mode

Input signals STROBE (1 bit), DATA (8 bits), SLCT IN, AUTO FEED, and INIT

Output signals BUSY (1 bit), ACK (1 bit), FAULT, SLCT, and PERROR

Input/output signal level TTL level

Transmission method Asynchronous
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产品中有毒有害物质或元素的名称及含量 

部件名称 

有毒有害物质或元素 

铅(Pb) 汞(Hg) 镉(Cd) 
六价铬 

(Cr(Ⅵ)) 

多溴联苯 

(PBB) 

多溴二苯醚 

(PBDE) 

印刷电路板 × ○ × ○ ○ ○ 

头部 × ○ ○ ○ ○ ○ 

壳体、底架 × ○ ○ ○ ○ ○ 

电源 × ○ × ○ ○ ○ 

其他（电缆、附件等） × ○ ○ ○ ○ ○ 

              

 ○：表示该有毒有害物质在该部件所有均质材料中的含量均在 GB/T26572-2011 标准规定的限量要求以下。 

 ×：表示该有毒有害物质至少在该部件的某一均质材料中的含量超出 GB/T26572-2011 标准规定的限量要求。

 

环保使用期限 

此标志适用于在中国国内销售的电子信息产品，表示环保使用期限的年数。 

所谓环保使用期限是指在自制造日起的规定期限内，产品中所含的有害物质 

不致引起环境污染，不会对人身、财产造成严重的不良影响。 

环保使用期限仅在遵照产品使用说明书，正确使用产品的条件下才有效。 

不当的使用，将会导致有害物质泄漏的危险。 
 

 

This product must be disposed of 
separately at your local waste recycling 
center. Do not dispose of in household 
waste bin. 

Bitte führen Sie dieses Produkt separat 
Ihrer örtlichen Entsorgungsstelle zu. 
Bitte nicht mit dem normalen Hausmüll 
entsorgen.

Ne jetez pas le produit avec vos 
ordures ménagères. Portez-le dans un 
centre recyclage des déchets.

Questo prodotto deve essere smaltito 
negli appositi contenitori per la raccolta 
differenziata, non buttare nel cestino 
dei rifiuti casalinghi.

Este producto debe devolverse al 
centro de reciclaje más cercano a su 
domicilio para su correcta eliminación. 
No lo tire a la basura.

Deite fora separadamente este produto 
no seu centro de reciclagem local. Não 
o deite fora no seu caixote do lixo.

Lever dit product in bij een lokaal 
afvalverzamelpunt. NIET met normaal 
huishoudelijk afval afvoeren.

Dette Produkt skal smides særskilt 
væk på den lokale affalds- og 
genbrugsstation. Må ikke smides ud 
sammen med almindeligt 
husholdningsaffald.

Tätä tuotetta ei saa hävittää 
normaalien talousjätteiden mukana, 
vaan se on toimitettava 
ongelmajätteiden keräilypisteeseen 
hävitettäväksi.

Produkten måste kasseras separat på 
din lokala återvinningscentral. Släng 
inte produkten tillsammans med 
hushållssoporna.

Μην πετάξετε το αντικείμενο αυτό στο 
καλάθι των απορριμμάτων. Αφαιρέστε 
τις μπαταρίες και προσκομίστε το στο 
τοπικό κέντρο ανακύκλωσης.

For China

For EU Countries

48





R5-120611

Please read this Agreement before unpacking the media.

Software license agreement

Roland DG Corporation (hereinafter referred to as the “Company”) shall grant you a non-transferable, nonexclusive right to use the 
Software supplied with this Agreement, on the condition that you agree to the following provisions.
If you agree to the following provisions, you should unpack the media on which the Software is recorded, or simply click the button 
or other indicator that you agree to the following provisions. By doing so, this Agreement shall be concluded.
If you do not agree with the following provisions, do not unpack the media. Or, you can click the button or other indicator that you do 
not agree to the following provisions of this Agreement. In this case, a license is not granted and you cannot use the Software.

1. Definition
The “Software” includes the software program and related files supplied with this Agreement and the related software programs 
and files distributed through the Internet and other services.

2. Ownership
All the ownership, copyright and other intellectual property rights of the Software, trademark, and related documents shall belong 
to the Company.

3. Terms and conditions
(1) You are authorized to use the Software on one computer.
(2) You are allowed to create a backup copy of the Software.
The right to keep the Software and the backup copy of the Software continues to belong to the Company, but the right to the 
media on which the backup copy of the Software is recorded does not belong to the Company.

4. Forbidden items
(1) This copy of the Software, or a backup copy of the Software, must not be used on multiple computers at the same time, on a 
network, the Internet, or on other computers through any other means of distribution.
(2) The Software shall not be reverse engineered, decompiled or reverse assembled.
(3) The rights to the Software cannot be transferred, assigned, lent, loaned or licensed to a third party in any case, regardless of 
whether this Agreement has been terminated or cancelled.

5. Termination
(1) The Company can cancel this Agreement and require you to discontinue use of the Software if you breach any provision of this 
Agreement or if you infringe on the ownership, copyright, or other intellectual property rights of the Company. (2) This Agreement 
shall be automatically terminated when you stop using the Software.
(3) If this Agreement is terminated or cancelled, you must return your copy of the Software to the Company, or discard it as soon 
as practicable, at your own expense.

6. Guarantee
(1) The Company shall not guarantee that the quality or functionality of the Software will satisfy any purpose that you may have 
in mind.
(2) The Company shall not accept any responsibility for the results obtained from using the Software.
(3) The Company shall not accept any responsibility for any loss which might be caused as a result of your exercising the rights 
granted under this Agreement.
(4) The specifications for the Software are subject to change without prior notice.

7. Governing Law
This Agreement shall be governed by the laws of Japan.
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